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Bilisim Egitim Grubu

Bilisim Egitim Grubu, 1999 yilinda bilisim teknolojileri alaninda egitim vermek amaciyla
kurulmustur. Temellerini istihdam ve verimlilik odakli bir yapi Gzerinde atmig ve verdigi
egitimlerle Turkiye'de yeni teknolojilere uyumlu bir egitim sistemi olugturmustur. Sahip
oldugu degerleri en guncel teknolojileri 6gretmek, kursiyerlerini hayallerindeki meslege
kavusturmak, kariyer sahibi yapmak ve istihdama yodnelik kaliteli i gtuclne katkida
bulunmak igin kullanmigtir. Misyonu ve vizyonu ile 6rtigen egitim igeriklerine yatirm
yaparak sektérde 6Snemili bir ilerleme kaydetmistir.

Bilisim Egitim Grubu, egitim sektérinde 6ncu olmanin bilinciyle, kaliteye ¢ok énem
vermektedir. EJitmen kadromuzun akademik egitimlerini ve sektdér deneyimlerini
o6grencilerimize en verimli sekilde aktarmalarini amagcglayarak hareket etmekte ve
verdigimiz egitimlerin igeriklerine blytk 6zen gbstermekteyiz.

Egitimini vermis oldugumuz yazilimlarin dev ureticileri basta;

Microsoft, Cisco, Adobe, Autodesk olmak UGzere Corel, ArchiCAD, Sta4-CAD, Nebim
gibi ig ortaklarinin da Yetkili EQitim Merkezi olarak hizmet vermekteyiz. Biligsim EQitim
Merkezi sahip oldugu vyetkinlikler ile egitim kalitesinde gucune gug¢ katan ve mezun
kursiyerlerine uluslararasi gegerlilige sahip sertifikasyon imkani sunan, sektérinde en
guvenilir ve en guglu egitim kurumudur.

is dinyasinin hizla dedisen trendlerini diglindugumuzde, sirketlerin bu degisime ve
gelisime ayak uydurarak, rekabetgi piyasalarda 6ne gikabilmeleri igin ¢aliganlarina
yatinm yapmalari kaginiimazdir. BEM, kurumsal gelisimin temelinde bireysel gelisimin
oldugu farkindahdiyla ve “En degerli yatirm, insana yapilan yatinmdir!” mantigryla
faaliyetlerine devam etmektedir. C6zim ortagr oldugumuz sirketlere de yatirimlarini,
bilgiyi yéneten bireylerine yapmalari gerektigini belirtmek istiyoruz. Kurumlar, Bilgi
Calisanlarini (Information Workers) yaratarak, kurumsal verimliligi yukselteceklerdir.

Bilisim Egitim Merkezi olarak hedefimiz;

C6zum ortagi oldugumuz kurumlara deger katan, fark yaratan projeler tretmek
ve en yuksek kalite standartlarinda egitim hizmeti sunmaktir.

Bilisim Egitim Merkezi, projelerinizde egitim aldiginiz kurum olmanin bir adim
6tesinde Kurumsal Egitim Partneriniz olmaya devam edecektir.
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270.000+
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Dinya
Standartiarindan
Ustln Egitim
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EGITIM MERKEZI Yeni Nesil
Egitim

1000+
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Uzman Egitmen
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DANISMANLIK
BiZ NELER YAPIYORUZ?

» Analiz, Planlama,

Optimizasyon, Kurulum,
Entegrasyon ve Sorun » Sanallagtirma Hizmetleri

Altyapi CozUmleri

B Sz etler ® Veri Merkezi Hizmetleri
» Bilisim Altyapi

Danismanhig ® Bulut Biligim Hizmetleri

> Bilgi Teknolojileri » Yedekleme Hizmetleri

o6ztmleri . .
¢ ®» Sunucu Yonetimi

’ o . ~ -
Guvenlik Danigmanligi ® IT Yatinm Danigmanligi

» Web & Mobil Uygulama

Geligtirme Hizmetleri Mih=tork Danigpanta 5.

® Guvenlik Testleri

B i i
Sosyal Medya Hizmetleri

Bilisim Egitim Merkezi,
Danigmanligi

Kurumunuzun ihtiyag duyacagi sistem, yazilim, bilgi gtivenligi ve teknik
alanlarda, alaninda uzman personelleri ile projelerinizi kisa slirelerde
tamamlayarak rakiplerinizden her zaman bir adim énde olmanizi saglar.
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KURUMSAL EGITIM
YAKLASIMIMIZ

Calismasi ve Onemi

Egitim ihtiyag Analizi Surecleri

« Egitim hedeflerinin belirlenmesi,

« Hedeflenen yetkinliklerin belirlenmesi,
« Seviye tespit sinavi ile seviyelerin
belirlenmesi,

« Gerekgeli egitim ihtiyag raporunun
sunulmasidir.

Egitim ihtiyag Analizi Yontemlerimiz

1. Birebir Goriigmeler: Analiz sUresince
caliganlar ve/veya bslim yéneticileri ile

bire bir gérigsmeler yapllir. Seviyelendirme
hakkinda ilk izlenim elde edilmig olur.

2. Anketler: Anket yontemi buyutk ¢aligan
gruplarinda kisa zamanda veri toplamak igin
etkili bir uygulamadir.

3. intiyag Analizi Formu: Bilgi teknolojileri
egitimlerinde, egitime konu olan programin
belirlenmis oldugu durumlarda kullanilir.
Egitim i¢eriginin Gzerine kurulu olan formlar
egitim almasi dustnulen personelce
doldurularak Bilisim Egitim Merkezi yetkilisine
teslim edilir. Bu formlar Gzerinde yapilan bir
caligma sonrasinda egitim ihtiyag raporu
hazirlanarak insan Kaynaklari yénetimine

sunulur.

Bilgi Teknolojileri Egitim Ihtiyac Analizi

Catx ile Seviye Belirleme Sinaviari

Biligsim egitimleri alaninda planlanan
egQitimlerde yuksek verimlilik saglanmasini
ve zamandan, maliyetten, ig gictnden
tasarruf edilmesini amaglayan bir
uygulamadir. Ozellikle MS Office yazilimlari
gibi personellerin ayri ayri yeterlilik
seviyelerine sahip oldugu programlarda
gruplarin olugmasindan hemen énce
uygulanmaktadir. Egitim gruplamasi bu
uygulama sonrasinda yapilmal ve seviyesi
birbirine yakin olan adaylarin birarada
egitim

almasi saglanmalidir.

Catx Seviye belirleme sinavlari ile;

« Ayni bilgi seviyesindeki kisiler gruplandirilir.
« Zaman verimli kullantlir.

« Egitimin verimliligi artirilir.

« Egitmen grubu yakindan tanir.

- icerigin seviyeye gore hazirlanmasini
saglanir.

Egitimin baginda yapilan seviye belirleme
sinavi sonuglari ile egitimin sonunda yapilan
6lgme sonuglari kargilastirildiginda aradaki
fark egitimin verimini ortaya ¢ikarmaktadir.

P
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EGITIiM MERKEZI

"Egitim ihtiyac¢ analizinin temeli, dogru zamanda, dogru calisan grubuna, dogru

icerik ve yontemlerle ihtiya¢ duyulan egitimin verilmesidir. Egitim kaynaklarinin

etkin ve etkili kulanimi ile egitimden beklenen verim artirilacaktir.”
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Yetkili Egitim Merkezi

GRAPHISOFT.

™ TRAINING
CORE PARTNER Dso lidWorks Yetkili Egitim Merkezi

Yetkili Egitim Merkezi olarak Bilisim Egitim Merkezi, bilisim teknolojisi profesyonellerine,
uygulama gelistiricilere ve bireylere diinya standartlarinda egitim ve servis vermek Ulzere
bir cok diinya devi tarafindan yetkilendirilmistir. Bu yetkinlikleri ile belirli donemlerde
denetlenmekte ve Ureticilerden aldigi, egitim icerigi, lisans, egitim dokiimani, egitim
uygulamalari gibi destekleyici materyal ile egitimleri diinya standartlari Ustlinden bir

seviyeye tasimaktadir.

Microsoft yetkili egitim merkezi’'nden egitim

amanin Avantajlari Nelerdir?

e Egitimler MCT'ler (Microsoft Sertifikali Egitmen) tarafindan verilir.
® Microsoft sertifikali egitmenler, Microsoft urlinlerini gelistirmede, uygulamada ve
desteklemede deneyim sahibi olup bu bilgilerini Microsoft standart kurs icerikleriyle

katiimcilara aktarmak icin yetistirilmis profesyonel egitimcilerdir.

“Bilisim Egitim Merkezi, Microsoft Yetkili Egitim Merkezi'dir.”

* Microsoft'un belirledigi fiziki standartlara sahiptirler.

e Egitimlerde Microsoft tarafindan hazirlanan egitim dékimanlari (DMOC) kullanilr.
* Musteri memnuniyeti yakindan takip edilir.

e Kurs bitiminde katilimcilara Microsoft onayli katihm belgesi verilir.

N P
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| B Microsoft MICROSOFT OFFICE EGITIMLERI

. Yetkili EQitim Merkezi

Microsoft Office Egitimleri

MSWRD Microsoft Word

MSEXS Microsoft Excel Standart

MSEXI  Microsoft Excel ileri

MSEXF Microsoft Excel Finansal

MSEBI  Microsoft Excel B

MSVBA Visual Basic for MS Excel

MSPWP Microsoft PowerPoint

MSOUT Microsoft Outlook

MSEST Microsoft PowerPoint ile Etkili Sunum Teknikleri
MSOZY Microsoft Outlook ile Zaman Yonetimi
MSPUB Microsoft Publisher

MSVSO Microsoft Visio

MSINF  MicrosoftS InfoPath

MSONE Microsoft OneNote

MSPBI  Power BI

MSTMS Microsoft Teams

MS365 Microsoft Office 365

Microsoft Project

MICROSOFI- 55180 Introduction to Microsoft Project Getting Started
OFFICE 55189 Tame Microsoft Project

EG'TIMLER' = : - ' : 55181 Microsoft Project Digging Deeper
55205 Mastering Microsoft Project

N ) > y
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MICROSOFT

Programming in C#

Developing Microsoft Azure and Web Services
C# Data Access with Entity Framework
Service Architecture and Web API

OOP and Design Patterns

Enterprise Design Patterns

Windows Presentation Foundation (WPF)

Windows Presentation Foundation (WCF)

Guvenli Yazilim Geligtirme

vV VvV VvV VvV vV vV VvV VvV v

HTML5 Application Development

ORACLE

BEMJV-1 Java SE: Programming | A= = = ~ :
BEMJV-2 Java SE: Programming II = i} 1= YUAZ"'IM .
BEMEE Developing Applications for the Java EE Platform E . ~ EGITIMLERI
BEMAE Architect Enterprise Applications with Java EE = & i :

BEMBE Java EE: Back - End Server Application Development
BEMFE Java Design Patterns
BEMDP Java EE: Front-end Web Application Development

P
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\

WEB & MOBIL

PROGRAMLAMA EGITIMLERI

WEB PROGRAMLAMA

Programming in HTMLS5 with JavaScript and CSS3
HTML5 Application Development

Angular

Node.js

ReactJS

Bootstrap

vV vV vV vV v v vV

Test Driven Development

MOBIL PROGRAMLAMA

» BEMMP-1 Swift ile iOS Uygulama Gelistirme Egitimi
» BEMMP-2 Android Uygulama Gelistirme Egitimi

» BEMMP-3 Xamarin ile Uygulama Gelistirme Egitimi

POWERSHELL
» 55207 PowerShell for SOL Administration

» 55202 PowerShell 5.0 and Desired State Configuration
» 55039 Windows PowerShell Scripting and Toolmaking

P
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10985
10986
10987
10988
10990
10994
10998
10999
20761
20762
20764
20765
20767
20768
20777
20779
55170
55232
55240
55246

Introduction to SQL Databases

Updating Your Skills to SQL Server

Performance Tuning and Optimizing SQL Databases
Managing SQL Business Intelligence Operations
Analyzing Data with SQL Server Reporting Services
Data Analysis Fundamentals using Excel

Updating Your Skills to SQL Server

SQL Server on Linux

Querying Data with Transact-SQL

Developing SQL Databases

Administering a SQL Database Infrastructure
Provisioning SQL Databases

Implementing a SQL Data Warehouse

Developing SQL Data Models

Implementing Microsoft Azure Cosmos DB Solutions
Analyzing Data with Excel

Writing Reports with Report Designer and SSRS Level 2
Writing Analytical Queries for Business Intelligence
Writing Reports with Report Designer and SSRS Level 3
SQL Alwayson High Availability
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SISTEM EGITIMLER]

10982
40336
40389
20740
20741
20742
20743
20744
55152
10991
40551
40552
40553
40554
20345 -1
20345 - 2
20703

vV VvV vV V VvV VV 9V VYV VVVV VvV VY

MICROSOFT

Supporting and Troubleshooting Windows 10
First Look Clinic: Windows 10 for IT Professionals
Windows Server® First Look Clinic

Installation, Storage, and Compute with Windows Server

Networking with Windows Server

Identity with Windows Server

Upgrading Your Skills to MCSA: Windows Server
Securing Windows Server

Fundamentals of Active Directory

Troubleshooting Windows Server Core Technologies
Enterprise Security Fundamentals

Managing Identity

Planning for a Secure Enterprise - Improving Detection
Implementing Windows 10 Security Features
Administering Microsoft Exchange Server

Designing and Deploying Microsoft Exchange Server

Administering System Center Configuration Manager

24
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AZURE EGITI

» 10979 Introduction to Microsoft Azure for IT Professionals

» 10992 Integrating On-Premises Core Infrastructure with Microsoft Azure

> 10993 Integrating On-Premises Identity Infrastructure with Microsoft Azure

» 20537 Configuring and Operating a Hybrid Cloud with Microsoft Azure Stack

» 40562 Migrating SQL databases to Azure

» 55195 Introduction to Microsoft Cloud Computing

» 552241 Microsoft Azure Big Data Analytics Solutions

» 552242 Operationalize Cloud Analytics Solutions with Microsoft Azure

» 55247 Designing and Implementing Cloud Data Platform Solutions

» 55257 Deploy and Manage Linux on Azure

» 103T00 Microsoft Azure Administrator i X ii i
» 10979 Introduction to Microsoft Azure for IT Professionals LI N UX EGITIMLERI
» 10992 Integrating On-Premises Core Infrastructure with Microsoft Azure

» 10993 Integrating On-Premises Identity Infrastructure with Microsoft Azure

» 20487 Developing Microsoft Azure and Web Services RHO024 Red Hat Enterprise Linux Technical Overview

> 99994 Cloud Computing Fundamentals RHO53 Red Hat Satellite Technical Overview

RH124 Red Hat System Administration |

RH134 Red Hat System Administration I

RH294 Red Hat System Administration Ill: Linux Automation

RH254 Red Hat System Administration Ill: Data Center Services for Red Hat Enterprise Linux 7
RH199 RHCSA Rapid Track Course

RH259 Red Hat Enterprise Linux for SAP Solutions

RH342 Red Hat Enterprise Linux Diagnostics & Troubleshooting

SANALLASTIRMA EGITIMLERI

RH362 Red Hat Security: Identity Management and Active Directory Integration
RH415 Red Hat Security: Linux in Physical, Virtual, and Cloud

RH436 Red Hat High Availability Clustering

RH442 Red Hat Performance Tuning: Linux in Physical, Virtual, and Cloud

BEMVM-1 VMware vSphere: Install, Configure, Manage

BEMVM-2 VMware vSphere: Optimize and Scale

BEMVM-3 VMware vSphere: Optimize and Scale plus Troubleshooting Fast Track
BEMVM-4  VMware vSphere: Fast Track

BEMVM-5 VMware vSphere: Skills for Operators

BEMVM-6 VMware vSphere: Troubleshooting Workshop

BEMVM-7  VMware vSphere: Skills for Public Sector Administrators

>
>
>
>
>
>
>
>
>
>
>
>
>

BEMUB Linux Ubuntu
BEMCT Linux Centos
BEMFD Linux Fedora
BEMMDLinux Mandriva
BEMPD Pardus

P y

vVVVYVVVYY

DIGER LINUX

EGIiTIMLERI

vVVVVvYeY
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Cisco Routing and Switching

100-105
200-105
300-101
300-115
300-135

Interconnecting Cisco Networking Devices Part 1 (ICND1)
Interconnecting Cisco Networking Devices Part 2 (ICND2)
Implementing Cisco IP Routing (ROUTE)

Implementing Cisco IP Switched Networks (SWITCH)
Troubleshooting and Maintaining Cisco IP Networks (TSHOOT)

210-260
300-208
300-206
300-209
300-210

Implementing Cisco Network (IINS)

Implementing Cisco Secure Access Solutions (SISAS)
Implementing Cisco Edge Network Security Solutions (SENSS)
Implementing Cisco Secure Mobility Solutions (SIMOS)
Implementing Cisco Threat Control Solutions (SITCS)

Cisco Service Provider

640-875
640-878
642-883
642-885
642-887
642-889

Building Cisco Service Provider Next-Generation Networks, Part 1 (SPNG1)

Building Cisco Service Provider Next-Generation Networks, Part 2 (SPNGNZ2)

Deploying Cisco Service Provider Network Routing (SPROUTE)

Deploying Cisco Service Provider Advanced Routing (SPADVROUTE)

Implementing Cisco Service Provider Next-Generation Core Network Services (SPCORE)

Implementing Cisco Service Provider Next-Generation Edge Network Services (SPEDGE)

Cisco Wireless

200-355
300-360
300-365
300-370
300-375

Implementing Cisco Wireless Network Fundamentals (WIFUND)
Designing Cisco Wireless Enterprise Networks (WIDESIGN)
Deploying Cisco Wireless Enterprise Networks (WIDEPLOY)
Troubleshooting Cisco Wireless Enterprise Networks (WITSHOOT)
Securing Cisco Wireless Enterprise Networks (WISECURE)

28
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Cisco Data Center

200-150 Introducing Cisco Data Center Networking (DCICN)

200-155 Introducing Cisco Data Center Networking Technologies (DCICT)
300-175 Implementing Cisco Data Center Unified Computing (DCUCI)
300-165 Implementing Cisco Data Center Infrastructure (DCII)

300-160 Designing Cisco Data Center Infrastructure (DCID)

300-180 Troubleshooting Cisco Data Center Infrastructure (DCIT)

Cisco Cyber Ops

210-250 Understanding Cisco Cybersecurity Fundamentals v1.0 (SECFND)
210-255 Implementing Cisco Cybersecurity Operations v1.0 (SECOPS)
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BILGI GUVENLI

BiLGi GUVENLIiGi EGITIMLERI

CND
CEH
CTIA
ECSA
LPT
APT
ECIH
CHFI
CSA
EDRP
ECSS
CASE
CSCuU
ECES
CNDA
CISO

Certified Network Defender

Certified Ethical Hacker

Certified Threat Intelligence Analyst
Certfied Security Analyst

Licensed Penetration Test

Advanced Penetration Test

Certified Incident Handler

Certified Hacker Forensic Investigator
Certified SOC Analyst

Disaster Recovery Proffessional
Certified Security Specialist
Application Security Engineer ((NET/Java)
Certified Secure Computer User
Certified Encryption Specialist
Certified Network Defense Architect
Certified Chief Information Security

30
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AG GUVENLIGi EGiTiMmi

Kali Linux EQitimi
Uygulamal Ag Guvenligi EQitimi

Ag ve Guvenlik Yoneticileri icin Linux Egitimi

ileri Seviye Ag Guvenligi EQitimi
Snort IPS/IDS Egitimi

DNS Guvenligi EGitimi

Pfsense Guvenlik Duvari EQitimi
OpenSource Guvenlik Duvari Egitimi
Linux ile Ag Guvenlik EQitimleri

iLERi DUZEY GUVENLIK EGiTiMLERI

DDOS Saldiralari ve Korunma Yollart Egitimi
Malware (Zararli Yaziim) Analizi Egitimi
Saldir Tespit, Analiz ve Log Yénetimi Egitimi
Guavenli Yazilm Geligtirme Egitimi
Veritabani Guvenligi Egitimi

Mobil Uygulama Guvenligi Egitimi

Siber Olaylara Mudahale Ekibi (SOME)

GUVENLIK TESTLERI EGiTiMi

Network Guvenlik Testleri Egitimi

Backtrack Guvenlik Testleri Egitimi

Kablosus Ag Guvenlik Testleri Egitimi
Metasploit Framework Guvenlik Testi Egitimi
Web Uygulamalari Guvenlik Testleri Egitimi
Nessus Zafiyet Analizi Egitimi

Sanallastirma Guvenligi EGitimi
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BT YONETIM

Project Management Professional (PMP)

Program Management Professional (PgMP)
Portfolio Management Professional (PfMP)
Certified Associate in Project Management (CAPM)
PMI Agile Certified Practitioner (PMI-ACP)

PMI Risk Management Professional (PMI-RMP)

PMI Scheduling Professional (PMI-SP)

PRINCE2 Foundation And Practitioner
PRINCE2 Foundation

PRINCE2 Practitioner

PRINCE2 Agile Foundation Certificate In Agile
Project Management

Prince2 Agile Practitioner Certificate In Agile
Project Management

Using Microsoft Project In A Prince2 Environment
Business Analysis For Project Managers
Managing Successful Programmes

Msp Re-Registration

32

EGITIMLERI

ITIL 4 Foundation Certificate In It Service
Management

ITIL 4 Foundation Certificate In It Service
Management - Fast Track

ITIL 4 Specialist: Create, Deliver And Support
ITIL 4 Strategist: Direct, Plan And Improve

Itil 4 Managing Professional Transition Module

ISTQB Advanced Test Manager Certificate
ISTQB Advanced Test Analyst Certificate
ISTQB Model Based Testing

ISTQB Advanced Technical Test Analyst
ISTQB Advanced Level Test Automation
Test Engineer

Working As A Scrum Master In Agile Teams
Professional Scrum Product Owner
Professional Scrum Developer (Generic)
Understanding Agile And Scrum
Professional Scrum Foundations
Professional Scrum Master

Safe Scrum Master

Managing Projects In Agile With Scrum

Professional Scrum Developer (.Net)

COBIT Foundation

BCS Specialist Certificate In Supplier Management
BCS Specialist Certificate In Problemm Management

BCS Specialist Certificate In Change Managemen

Certified Information Systems Security
Professional (CISSP)

Professional Certified In Risk And Information
Systems Control (CRISC)

Is027001

Guvenli Yazilm Gelistirme

33
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AUTODESK EGITIMLERI

YETKILI EGITIM MERKEZ]

Bilisim Egitim Merkezi, cad programlarinin bir numarali Ureticisi olan ve diinyada 75 iilkede hizmet
veren Autodesk firmasinin “Yetkili Egitim Merkezi” unvanina sahiptir.

Autodesk; Mekanik, Mimari, ingsaat ve Cografi CAD yazilimlari konusunda oldugu kadar medya ve
eglence sektériine de yonelik yazilm ve sistemleriyle gelecegin standartlarini belirleyen firmadir.

Autodesk Yetkili Egitim Merkezi' nden Egitim Almanin Avantajlar::

Autodesk Yetkili Egitim Merkezi'nden alacaginiz egitim sonundaki proje calismasini basari ile
tamamladiginizda uluslararasi gecerlilige sahip Autodesk Sertifikasi alirsiniz. Egitmenleri Autodesk
onaylidir. Autodesk Yetkili Egitim Merkezi olarak Autodesk Instructor belgesine sahip egitmenlerle
egitim verilir. Autodesk tarafindan onaylanmis egitmenler ile ¢izim ve tasarim programlarinda
profesyonel egitim alma sansina sahip olursunuz. Autodesk lisansh egitimleri ile daha yliksek
standartlarda egitim alma imkanina sahip olursunuz.

Egitim ve kalite seviyesi Autodesk denetimi altindadir. Autodesk firmasinin kalitesi, glivenirliligi,
egitim anlayisi egitimlerimize yansiyarak daima kalitesiyle 6n plana cikan bir egitim anlayisina
sahip bir kurumdan egitim alirsiniz.

AUTODESK EGIiTIMLERI DIGER TEKNIK EGITIMLER

» AutoCAD-2D » Sta4-CAD » Dialux

» AutoCAD-3D » SAP2000 » Dialux Evo

» 3Ds Max-Essentials » ideCAD » Matlab

» 3Ds Max-Advanced » Probina » Cinema 4D
» 3Ds Max-Intermediate » Xsteel (Tekla) » Rhinoceros 3D
» 3Ds Max-Vray » ArchiCAD » Lumion 3D

» Revit Architecture » NetCAD GIS » SkecthUp 3D
» Revit Structure » ArcGIS » NX Cad-Cam
» Revit MEP » SolidWorks

» Inventor » Catia

» AutoCAD Civil 3D

» AutoCAD Map 3D

» AutoCAD Electrical

» Fusion 360

» Maya =

AUTODESK

Authorized Training Center
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Corel DRAW

Graphics Suiute

\

Grafik &
Web Tasarim

Egitimleri

"‘ ‘ Adobe Yetkili Egitim Merkezi

Adobe

GORSEL ILETiSIM &
WEB TASARIM EGITIMLERI

GRAFiIK TASARIM EGiTiMLERI

Adobe Photoshop

Photoshop ile Dijital Fotografcilik
Phoshop ile Mimari Gorsellestirme
Adobe Indesign

Adobe lllustrator

Adobe Acrobat Reader

Adobe Lightroom

Adobe Premier Pro

Adobe After Effects

Adobe Dimension

vV VvV vV vV V9V VYV VVYY

CorelDraw

WEB TASARIM EGIiTiMLERI

®» Adobe Dreamweaver Html 5 - CSS3 - Java Script
» Adobe Bridge Wordpress
®» Adobe Fireworks JQuery

» Adobe Photoshop
®» Adobe Muse

Responsive Design

vV VvV VvV V@Y

Hosting & Domain

&/
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DIJITAL PAZARLAMA UZMANLIGI

INTERNET REKLAMCILIGI EGITIMLERI

TEORI EGITIMLERI PC UYGULAMALI EGIiTIMLER

» Dijital Pazarlamaya Girig » Adobe Photoshop
» E-Ticarete Girig » HTML5
» interaktif Marka ve Kurumsallagma » CSS3
Teknikleri » JavaScript
» Bulten Hazirlama Teknikleri » Dreamweaver
» Search Engine Optimization (SEO) » Wordpress
» Google Adwords » Adobe After Effects
» Google Adsense » Adobe Premiere Pro
» Google Analytics
» Google Tag Manager (GTM)
» Facebook Reklom ve Pazarlama
» Instagram Reklam ve Pazarlama
»  YouTube Reklam ve Pazarlama
» Blog Reklam ve Pazarlama
» Mobil ve E-Mail Pazarlama

DIJITAL
PAZARLAMA
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EGITIM SALONU HIZMETLERIMIZ

“Akilli Bina Ozelligini Tasiyan Ozgiin Tasarimli Siniflar”

Istanbul’un Kalbindeki
Kurumsal Ortaginiz!

Cagimiz modern egitim anlayisini benimseyen Bilisim Egitim Merkezi, talepler
dogrultusunda, insanlarin egitim alirken bulunduklari ortamdaki konforlarina iliskin hizmet
gereksinimlerini ve ihtiyaglarini 6nceden belirleyerek, akilli bina 6zelliklerini tasiyan,
6zgun tasarimh binasinda toplanti ve egitim diizenlemek isteyen tim kurumlara Ustin
teknolojiyle donatilmig siniflarinda hizmet vermektedir.

Bilisim Egitim Merkezi akilli siniflarinda her kullanici
icin modern teknolojiyle donatilmis, yliksek kapasiteli
bilgisayarlar bulunmaktadir; béylece her kullanici digerinden
bagimsiz calisabilmekte ve toplantidan maksimum verim
alinabilmektedir. Ustelik konum itibariyle Kadikdy'iin

bolgede tek olma 6zelligine sahip, 270° Panaromik Deniz
ve istanbul manzarasiyla, kullanicilarina molalari icin essiz

bir huzur ve gorsel sélen sunmaktadir.

P

Modern Teknolojili
Bilgisayar Laboratuvarlari!

Zamanin 6neminin farkinda olan Bilisim Egitim Merkezi, kurumlarin is toplantisi ve egitim
ihtiyaclarini karsilamak amaciyla istanbul ve Anadolu Yakasinda egitim faaliyetlerini
surdirmektedir.

Hizmet verdigimiz subelerimiz;

Kadikdy, Besiktas, Bakirkdy ve Ankara (Kizilay)

Asya ve Avrupa kitasindan her tiirli toplu tasima imkaniyla ulagimin miimkiin oldugu
merkezi tesisini, bilgisayarli egitim salonu ihtiyaci olan tim kurumlarin hizmetine
sunuyor.

Bilisim Egitim Merkezi bilgisayar laboratuvarlarinda, konforlu bir egitim ve toplanti
ortami sunulmasi amaciyla; gorsel sunum, ses ve isik yalitimi ve hava dongusu
disunulerek; ortam isisi uygun hale getirilebilecek bicimde hazirlanmistir. Ayrica bu
laboratuvarlarda 6zel donanimli, son teknolojik 6zelliklere sahip akilli tv uygulamalari
esliginde; daha 6nce hicbir kurum tarafindan uygulanmamis olan ergonomik calisma
koltuklarina sahip, 6zel tasarimli ve son teknoloji trendleriyle zenginlestirilmis egitim

masalarindan faydalanilmaktadir.
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BILISIM\

EGITIM MERKEZI

Cat)(

Computer Adaptive Test

INGILIZCE OLCME ve

DEGERLENDIRME TESTI

Catx, yapay zeka o6zelligi sayesinde, sinavi kisisellestirerek kullaniciya 6zel bir sistemle en dogru
sonuca, en kisa slirede ulasiimasinisaglayan web tabanli bir uygulamadir.

Catx, kisinin bireysel yeteneklerine uyarlandigi icin kullaniciya uyarlamali (User Adaptive)
ozellige sahip bir sinav sistemidir. Yapay Zeka 6zelligi ile, uzman egitmen kadrosu tarafindan

Kullanim
Alanlari1 Nelerdir!

“Bayuk - kiigUk tim igletmeler, kamu
kurumlari, vakif ve dernekler, sivil toplum
kuruluglari, 6rgiin ve 6zel egitim kurumlarinin
yaninda bilgi seviyesini 6lgmek isteyen
herkes kullanabilir.”

hazirlanmis binlerce soru icerisinden kullanicinin performans seviyesine en uygun sorulari
secerek kullanicinin becerisini lgmeye rehberlik eder.Secilen soru daha 6nceki performansa
baglidir. Soru cevaplandiktan sonra yazilim aninda geri bildirim saglar. Kullanicinin verdigi

cevaplara gore daha kolay veya daha zor bir soru sormaya veya testi sonlandirmaya karar
vererek seviyenin belirlenmesinde en dogru sonuca ulasir.

Gunlimuzde de artik hemen hemen her alanda kullanilan “Bilisim Teknolojileri Sistemleri” ile
bunlara bagl olarak gelistirilen yazilimlarin sinav ve test sistemlerinde de kullaniimasi kaginilmaz

hale gelmistir. Tiirkiye’nin ilk ve Tek User Adaptive Olgme ve Degerlendirme Testi Catx, . e
Mevcut personelin geligime ihtiyag

duyduklar yénlerini kesfedebilir veya egitim
verimliliklerini élgebilirsiniz.

bilgisayar ortaminda bireye uyarlanmis sinav ve test sistemidir.

OF:0]

:

Is Verenler

Adaylarin Yeterliligini Uzmanlarca
Hazirlanmus Testler ile Tespit Edin!

Sirket Ici Egitimler Egitim Kurumlar:
Catx ile Sirketi¢i Egitim Catx ile Egitim
Stirecini Geligtirin! Kalitenizi Yiikseltin!
43
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BIREYSEL EGITIMLER & EGITIM PAKETLERI

YAZILIM 360 EGITIMLERI TEKNIK EGITIMLER

» Yazilm Uzmanligi Egitimi (MCSD) » AutoCAD Kursu » Civil 3D
®» Python Programlama » 3ds Max Kursu » RhinoCeros
» Java ®» Revit ® ileri Diizey Mimari
®» iOS&iPad Mobil Uygulama Gelistirme » ArchiCAD » Gorsellestirme
» Android Mobil Uygulama Gelistirme » Maya » MS Project
» Xamarin Mobil Uygulama Geligtirme » STA4-CAD » Autodesk Fusion 360
» Hadoop ve Big Data » SAP2000 » Lumion 3D
» MS SQL Database » XSteel ®» Teknik Resim
» Yazilim Plus » SolidWorks » 3D Animasyon Paketi
®» Inventor » Autodesk Maya
» ArcGIS » Cinema 4D
» AutoCAD Map 3D

SiISTEM 360 EGITIMLERI NETWORK 360 EGITIMLERI

» CCNA (Cisco Certified Network Associate)
» CCNP (Cisco Certified Network Professional)
» CCNA Security

» CCNP Security

Sistem Uzmanligi (MCSE)
Sistem Plus

Server Yonetim Ailesi

Sistem Guvenligi

>

>

>

» Sanallastirma
>

» Birlesik Mesajlagma
>

Linux Egitimi

48
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DUITAL PAZARLAMA UZMANLIGI

GRAFIK ve WEB TASARIMI

Grafik Tasarim
Web Tasarim
Tekstil Grafigi Egitimi

Dijital Pazarlama Uzmanhgi Egitimi Kursu
Google AdWords Egitimi Kursu

Google Analytics Egitimi Kursu

SEO Egitimi

Sosyal Medya Uzmanhgi Egitimi

E-Learning Hazirlama Egitimi
Hareketli Grafik Sanati
(Motion Graphics Art)

VvV VvV vV VY Y
vV vV VvV VYV

Bitcoin ve Dijital Para Egitimi

MICROSOFT OFFICE BILG. MUHASEBE ve FINANS

®» Microsoft Office
®» Microsoft Excel (ileri) ®» Nebim V3
» Veri Raporlama ve Is Zekasi (Power BI) » SAP

KARIYER KART (1 ve 2 Yil)

» Bilgisayarli Muhasebe

BiLGi GUVENLIGi

BiLiSIM JUNIOR EGITIMLERI

®» Ethical Hacking (Hacker Egitimi)

KARIYER PLUS PAKET EGITIMLERI

ENDUSTRI’

PWS<

MIMAR’ TASARIM

PLWUS< PLUS<

ELEKTRIK HARITA

PLUS< PLUSO

INSAAT MAKINE

© PLWUSD PLWUST
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BILISIM

EGIiTIM MERKEZ
“Gelecek Bilisim’de”
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